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Section 1 Software overview

This UCI software from Sea-Bird Scientific currently supports several sensors and is the
interface for new products. Other sensors will be added as is practical. Supported
sensors:

• SUNA V2 
• HydroCAT-EP V2
• HydroCAT
• ECO V2 
• SeaFET
• SeapHOx

Note that this software does not support the "Classic" ECO or older versions of SUNA,
SeaFET, or SeapHOx.

1.1 Install and start software
Install the manufacturer-supplied software and make sure that the sensor is ready to test
for functionality before configuration and deployment. If the sensor is so equipped, install
the batteries if necessary. The manufacturer-supplied UCI software communicates with a
number of sensors. The sensors that are supported are listed in the Sensor menu of the
software.

1. Get the software from the manufacturer's website or the manufacturer-supplied USB
drive or CD.

2. Install the appropriate software.

a. For Windows®: Double-click on the file with ".exe" appended to the name.
b. For Mac OS X®: Double-click on the file with ".pkg" appended to the name. Make

sure that the default "Install for all users on this computer" is selected as the
destination for the installed software. If "Install for me only" or "Install on a
specific disk" is selected, the software will not connect to the sensor.

3. Push Run in the new window.
The setup wizard starts.

1.2 Sensor dashboards
The Dashboard is the main area from which to control and communicate with the sensor.
Information about the status of the sensor is contained in the upper part of the window
and is updated each time the sensor is connected to the software. To see the dashboard,
select it from the View | Dashboards menu item.
Common settings

• Connect-Disconnect lets the user disconnect the sensor after it is set up for
operation.

• Start-Stop lets the user start and stop data collection.
• Sensor Settings lets the user select options for a specific deployment.
• Deployment Wizard lets the user select a deployment mode, start time, the

parameters to measure, estimate the deployment time and data collection interval,
and make a summary report of the status of the sensor.

• Transmit Data lets the user move data saved on the sensor to a PC.
• Show Saved Data lets the user see data that was saved on a PC in a graph.
• Command Terminal lets the user send terminal program-level commands to the

sensor.
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Section 2 SUNA V2

2.1 Settings tabs
Push [Sensor] Settings to change the settings of a connected sensor to verify sensor
function or set up for deployment.

2.1.1 General tab settings
The user can deploy the sensor in an autonomous or a logger-controlled mode.

1. If necessary, change the Operational Mode, or push Default to use the manufacturer-
set values.

• Continuous operation—when started, the sensor operates until the user removes
power or pushes Stop in the SUNA Dashboard.

• Fixed-time operation—the sensor operates for a user-specified period of time or
number of measurements.

• Periodic operation—the sensor operates at user-specified intervals. Data
collection begins at a user-specified date and time and stops when the user
removes power or pushes Stop in the SUNA Dashboard.
Example: a sensor set up at 8:00 with a "Sample Interval" of 2 hours and an
offset of 900 seconds (15 minutes) will operate at 10:15, 12:15, 2:15, etc.

Logger-controlled modes

• Polled operation—the sensor communicates through and is controlled by an
RS232 terminal program.

• SDI-12—The sensor communicates through and is controlled by an
SDI-12 controller.

2. Select the Operational Mode Settings. The Sample Averaging and Deployment
Characteristics change as the operational settings change.

3. If the sensor has a wiper, put a check in the "Integrated Wiper Enabled" to operate
the wiper.
The wiper operates once before each measurement.

4. Use the default SUNA Messages as "INFO."
5. Push Upload to change the settings in the software.

2.1.2 Communication
Go to the Telemetry tab in SUNA Settings to set up communication and data file types.
The default serial baud rate is 57600.
The default for "Transmitted Frame Format" and "Data Format" is "FULL_ASCII."

• FULL_ASCII—Contains all collected data in comma-separated fields. The file
extension is .csv. The frame size is typically 1600–1800 bytes. Use this format so
that data can be reprocessed.

• NONE—For "Transmitted Frame Format" data output is turned off. For "Data Format"
sensor data storage is turned off.

Other available formats:

• FULL_BINARY—Contains all collected data. The file extension is .bin. The frame
size is 632 bytes. Use this format so that data can be reprocessed.

• REDUCED_BINARY—Contains data from part of the spectrum and data from some
auxiliary sensors. The file extension is .bin.The frame size is 144 bytes. Use this
format so that seawater data can be reprocessed.

• CONCENTRATION ASCII—Contains a time-stamp, nitrate concentration,
absorbance at 254 and 300 nm and Root Mean Square Error (RMSE) to measure the
quality of the data. The file extension is .csv.
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• APF—Deep SUNA V2 only. Used for APEX floats. Contains the user-selected parts
of the spectrum and other auxiliary sensors. The frame size is typically
300–400 bytes.

• The user can set the "Transmitted Frame Format" to "NONE" to turn off data output.
This increases the rate at which data is collected, and uses 10–30% less power.

• The user can set the "Frame Format" to NONE to turn off internal data collection.

The default "File Creation Method" is "By File Size." Others are available:

• By File Size—The software makes a new file when the data file in use gets to the
user-selected maximum size. The file name starts with "C" ("Continuous" file).

• By Sample Event—The software makes a new file when data collection starts for the
first time after the power has been turned off, then on. The manufacturer
recommends that the user select this for test purposes only. Use of this setting can
result in so many stored files that the sensor operates slowly or incorrectly. The file
name starts with "A" ("Acquisition" file).

• Daily—All data that is collected during a calendar day is put into a single file. This file
name is a seven-digit number that is the year and the day of the year, for example,
D2015142.csv. The file name starts with "D" ("Date-stamped" file).

The default "Maximum File Size" is 2 MB when the "Mode of Operation" is set to
"Continuous." It is user-selected from 1–65 MB. The "Daily" and "Sample Event" files
contain all of the data that is collected during the day or during one cycle of operation.

2.1.3 Advanced tab settings
The manufacturer recommends that the user change only the "Salt Water Calibration"
setting in this tab. Put a check in the "Deployed in Fresh Water" box if the sensor is
deployed in fresh water. Put a check in the "Bromide Trace" box to enable this feature.
Push Upload.

2.2 Deployment wizard
The deployment wizard makes it easy to set up the sensor for a specific deployment.

1. Select the Operational Mode. Push Next.

• Continuous: sensor collects data continuously.
• Periodic: sensor collects data for a user-set time or number of samples at user-

set interval.
• Fixed time: sensor collects data for a user-set amount of time.
• Polled: sensor collects data as commanded by a controller.
• SDI-12: sensor collects data as commanded by a SDI-12 controller.
• APEX Float: (Deep SUNA only):sensor collects data as commanded by the

APEX float controller.
2. Select the General Settings.

a. Periodic mode: "Sample Interval" from 1 minute to 24 hours between each
sample collected. "Offset" is****

b. Select "Frame Based Operation" or "Time Based Operation."
c. Enter a value between 1–65535 for the "Frame Cycle."
d. Enter a value between 1–200 for the "Number of Measurements to Average."
e. If the sensor has a wiper: put a check in the box at "Wiper Settings" to enable the

wiper.
f. Select the "Level." "INFO" is the default. Refer to the Message tab on page 34

for details about the levels.
g. Push Next.

SUNA V2
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3. Select the Data Settings.

a. Select the "Transmitted Frame Format." FULL_ASCII" is the default.
b. Select the "File Creation Method." "By File Size" is the default. Refer to 

Communication on page 5 for details.
The manufacturer recommends that the user selects

c. Push Next.
4. Select whether the sensor will be deployed in fresh water or seawater. Push Next.
5. Make a Deployment Report for a record of the settings stored in the sensor.

2.3 Update the reference value
1. Push Reference Update.

The "Reference Update Wizard" shows.
2. Fill the sample volume with distilled water. Refer to the hardware user manual for

details.
3. Make sure the "Operational Mode" is set to "Continuous," then push Next.
4. The sensor starts to collect data. This will take approximately 30 seconds.
5. Push Next.
6. Look at the graph to see the change between reference spectra.
7. Push Next.
8. Push Browse to select a directory in which to save the Calibration Report.
9. Optional: write a comment.
10. Put a check in the "View" box to automatically open the new report.
11. Put a check in the "View" box to automatically open the new calibration file.
12. Push Finish.

The software makes a report and a calibration file.

2.4 Verify sensor transmits data

N O T I C E
 

Use only the batteries recommended by the manufacturer as replacements. Do not mix
chemistries, V-Ah, or new and used batteries.

If the sensor is equipped with internal memory, the collected data is saved in the sensor.

1. Push Transmit Files in the SUNA Dashboard area.
The files saved by the sensor show on the right side of the new File Manager
window.

SUNA V2
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2. Select one or more files to transmit to the PC.
The manufacturer recommends that the user use a USB connection to move the files
because it is much faster.

3. Push the <- arrow to start the move.
The status shows at the bottom of the File Manager window.

4. Open the file on the PC to make sure it has all of the collected data.

2.5 Operate wiper
If the sensor is equipped with a wiper, make sure that the wiper operates correctly.
Push Check wiper to operate the wiper for one cycle.

SUNA V2

8



Section 3 HydroCAT

3.1 Settings tabs
Push [Sensor] Settings to change the settings of a connected sensor to verify sensor
function or set up for deployment.

3.1.1 Set up output format
The parameters selected in this tab change the data that is moved to the PC and the data
that shows in the Real Time Display tab. Parameters that are not selected are still
collected and stored as data by the sensor but do not show in the Real Time Display tab.

1. On the Output Format tab: if necessary, change any of the Parameter Units.
2. If necessary, change any of the Parameters to Output, or push Default to use the

manufacturer-set values.

• Temperature
• Pressure
• Conductivity
• Oxygen
• pH
• Chlorophyll fluorescence
• Turbidity
• Salinity
• Sound velocity
• Specific conductivity
• Sample number

3. Push Apply to save the values in the sensor.

3.1.2 Set up data collection
Select the Data tab to set the interval at which the sensor collects data.

1. Select the Data tab to set the interval between samples.
The sensor collects data at the end of the specified interval.

2. Enter a value between 10–21600 seconds in the "Sample Interval" area.
3. Put a check in the box so that the data collected during a deployment is sent to a

controller or logger and the user can see the data in real time.
The software enables the "Transmit Real Time" setting whether or not there is a
check in the box. The data shows in real time while the sensor is connected to the
software.

3.1.3 Set up pump operation
Select the Pumping tab to set the values for the operation of the pump. Enter the
"Minimum Conductivity Frequency" in the Pumping tab. This value is the Zero
Conductivity Frequency from the manufacturer-supplied calibration page plus the offset
value for either salt water (500 Hz) or fresh water (1 Hz). This sum is the minimum
conductivity frequency at which the pump will operate.

1. If necessary, change the "Minimum Conductivity Frequency."
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• If the sensor is set up to operate in an autonomous mode, the pump will operate
a "pre-flush" for a manufacturer-set default of 300 seconds before data is
collected. This removes air from the plumbing and primes the pump. The user
can enter a value from 300–600 seconds for the "Pre-flush Duration."

• If the sensor is set up to operate with a controller ("polled" mode), put a check in
the box next to " Scheduled Pre-flush for Polled Sampling." Make sure to set the
pre-flush cycle to complete before the sensor starts to collect data. Data
collection will cancel the pre-flush operation.

2. Select the "Start Date."
3. Select the "Start Time" (hours).
4. Push Apply.

3.2 Deployment wizard
1. If necessary, make sure that the sensor is connected to the software.
2. Push Deployment Wizard in the Dashboard of the connected sensor.
3. Deployment Setup step 1: Select "Autonomous Sampling," or "Polled Sampling"

(SDI-12 or RS232).
4. Push Next.
5. Deployment Setup step 2: For "Autonomous Sampling": Set the date and time to

start data collection. Then push Next.
Put a check in the box next to "Transmit Real Time" to see the data as it is collected
in a terminal program or a data controller. If the user does not put a check in the box,
the sensor still collects and saves data, but it does not show the data in real time.

6. Deployment Setup step 3: For "Polled Sampling (SDI-12)": The manufacturer-set
default address is 0. Users can change this if necessary. Use the "Bad Data Flag"
default value of 9999999, then push Next.

7. Deployment Setup step 4: If necessary, change any of the settings in the Parameter
Units area and Parameters to Output.

HydroCAT
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8. Deployment Setup step 5: Enter the minimum conductivity frequency. Refer to the
section on Conductivity check on page 12 for details on this value.

• Fresh water deployment—add a 1 Hz offset to the zero conductivity value of the
sensor.

• Salt water deployment—add a 500 Hz offset to the zero conductivity value of the
sensor.

9. Deployment Setup step 6: Put a check in the box to set the internal clock of the
sensor to the same time as the PC.

• Put a check in the box "Clear HydroCAT/EP data" to erase the data from the
internal memory of the sensor.

• If necessary, enter a pressure offset. If the sensor is deployed at sea level, enter
0.0 in the "Pressure Offset" area. The range is from -3402823 to 3402823.

10. Deployment Setup step 7: Enter the approximate minimum temperature of the water
in which the sensor will be deployed.

• Enter the approximate depth of water in which the sensor will be deployed.
• Enter the time interval between each sample for either autonomous or logger-

controlled (polled) operation.

• Range for HydroCAT: 10–21600 seconds
• Range for HydroCAT-EP: 75–21600 seconds

The calculated battery capacity and the number of 24-hour periods that the sensor
can operate is given as a reference. Note: The software calculates "Battery
Endurance" for new batteries only. Deployment time decreases for used batteries.

11. Push Next.
12. Deployment Setup step 8 (optional): make a Deployment Report.

• Enter the "Operator Name."
• Enter any text in the "Comments" area.
• Push Browse to change the location at which the report is saved on the PC.
• Put a check in the box next to "Overwrite if Existing" to save the new report only.

13. Push Finish. The sensor disconnects from the software.

• If the sensor was set up in a logger-controlled or "polled" mode, use the controller
unit to control the collection of data.

• If the sensor was set up in an autonomous mode and there is a check in the
"Transmit in Real Time" box from Step 2 of the Deployment Setup, start a
terminal program to monitor data in real time.

14. When the deployment is complete, the user can connect to the software again and
push Transmit Data in the Dashboard to move the data that is saved in the sensor to
the PC.

3.3 Performance checks
3.3.1 Temperature check

1. Push Temperature Check in the Dashboard area.
2. Push Next to start the check.
3. Enter the water temperature in °C in the "Temperature" area.
4. Push Start.

The software takes a few minutes to collect data for the test. The results show in the
"Status" area.

HydroCAT
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5. Push Next.
6. Push Next.

The software saves a .pdf report in the user-specified location on the PC.
7. Push Finish.

The Temperature Check window closes and the .pdf report shows if the "View" box
has a check in it.

3.3.2 Conductivity check
The software lets the user do both a zero conductivity check and a check to a user-
supplied conductivity standard.

1. Push Conductivity Check in the Dashboard.
2. Push Next to start the check.
3. At step 2 of 6, "Zero Conductivity Frequency Check": enter the first value from the

"INST FREQ" column on the calibration page supplied by the manufacturer.
4. Push Start.

5. Push Next.
The software shows the steps to complete the check for the user-supplied
conductivity standard.

6. Push Next.

HydroCAT
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The software is ready to do the check of the user-supplied conductivity standard.
7. Enter the value of the conductivity standard in step 4.
8. Push Start.
9. The user can make a report.

• Enter any text in the "Notes" area.
• Push Browse to change the location where the report is saved on the PC.
• Change the "Report File Name."
• Put a check in the "View" box so that the report automatically opens when it is

completed.
• Put a check in the "Overwrite file if it already exists" box to save only the new

information.
10. Push Finish.

The Conductivity Check window closes and the report opens if the "View" box has a
check in it.

3.4 Transmit data
1. Push Transmit Data in the Dashboard area.

The Transmit Data window shows.

• Information in the Memory Summary lets the user see the available data storage
in the sensor.

• "Bytes" is the amount of memory in use.
• "Samples" is the number of samples the sensor has collected and stored.
• "Free Samples" is the number of samples the sensor can store.
• "Sample Length" is sensor-specific and shows the length of each data record

that the sensor stores.
2. In the "Transmit Type" drop-down menu in the Data Transmit Options area, select

either "All Data" or "Block size (bytes)."

• "All Data": all data stored in the sensor is transmitted to the PC in both .csv
and .sbsdat file types.

• "Sample Number Range": a user-specified range of samples. Select the specific
samples in the Sample Number Range area.

3. In the Data Transmit area, the software automatically selects the fastest baud rate to
use to transmit data, which is typically115200.
The software temporarily increases the sensor's baud rate to upload data more
quickly. After the transmission is complete, the software changes the baud rate to
what it was before data was transmitted.

4. In the Output CSV Data File area, type a new file name or use the automatically
generated file name.

HydroCAT
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5. Optional: change the time stamp to UTC.
6. Push Transmit.

• The data is transmitted to the PC.
• The software saves a raw .sbsdat file and automatically converts the data to a

readable .csv file type.
• The Transmit Progress window shows the status of the file transmission and

conversion.
• The default is a check in the boxes for "Show Data when Conversion Completed"

and "Close this Dialog when Conversion Completed."

HydroCAT
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Section 4 HydroCAT-EP V2

4.1 Settings tabs
Push [Sensor] Settings to change the settings of a connected sensor to verify sensor
function or set up for deployment.

4.1.1 Set up output format
The parameters selected in this tab change the data that is transmitted to the PC and the
data that shows in the Real Time Display tab. Parameters that are not selected are still
collected and stored as data by the sensor but do not show in the Real Time Display tab.

1. Push Settings in the Dashboard of the connected sensor.
2. On the Output Format tab: if necessary, change any of the Parameter Units.
3. If necessary, change any of the Parameters to Output, or push Default to use the

manufacturer-set values.

• Temperature
• Pressure
• Conductivity
• Oxygen
• pH
• Chlorophyll fluorescence
• Turbidity
• Salinity
• Sound velocity
• Specific conductivity
• Sample number

4. Push Apply to save the values in the sensor.

4.1.2 Set up data collection
1. Select the Data tab to set the interval between samples.

The sensor collects data at the end of the specified interval.
2. Enter a value between 10–21600 seconds in the "Sample Interval" area.
3. Put a check in the box so that the data collected during a deployment is sent to a

controller or logger and the user can see the data in real time.
The software enables the "Transmit Real Time" setting whether or not there is a
check in the box. The data shows in real time while the sensor is connected to the
software.

4.1.3 Set up pump operation
Select the Pumping tab to set the values for the operation of the pump. The software
automatically gets the Zero Conductivity Frequency and the Minimum Conductivity
Frequency values from the connected sensor and shows them in the Pumping tab. The
Minimum Conductivity Frequency value is the Zero Conductivity Frequency plus the offset
value for either salt water (500 Hz) or fresh water (1 Hz). This sum is the minimum
conductivity frequency at which the pump will operate.

1. If necessary, change the "Minimum Conductivity Frequency."
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• If the sensor is set up to operate in an autonomous mode, the pump will operate
a "pre-flush" for a manufacturer-set default of 300 seconds before data is
collected. This removes air from the plumbing and primes the pump. The user
can enter a value from 300–600 seconds for the "Pre-flush Duration."

• If the sensor is set up to operate with a controller ("polled" mode), put a check in
the box next to " Scheduled Pre-flush for Polled Sampling." Make sure to set the
pre-flush cycle to complete before the sensor starts to collect data. Data
collection will cancel the pre-flush operation.
Select the "Start Date."
Select the "Start Time" (hours).

2. Push Apply.

4.2 Deployment wizard
1. If necessary, make sure that the sensor is connected to the software.
2. Push Deployment Wizard in the Dashboard of the connected sensor.
3. Deployment Setup step 1: Select "Autonomous Sampling," or "Polled Sampling"

(SDI-12 or RS232).
4. Push Next.
5. Deployment Setup step 2: For "Autonomous Sampling": Set the date and time to

start data collection. Then push Next.
Put a check in the box next to "Transmit Real Time" to see the data as it is collected
in a terminal program or a data controller. If the user does not put a check in the box,
the sensor still collects and saves data, but it does not show the data in real time.

6. Deployment Setup step 3: For "Polled Sampling (SDI-12)": The manufacturer-set
default address is 0. Users can change this if necessary. Use the "Bad Data Flag"
default value of 9999999, then push Next.

7. Deployment Setup step 4: If necessary, change any of the settings in the Parameter
Units area and Parameters to Output.

8. Deployment Setup step 5: Enter the minimum conductivity frequency. Refer to the
section on Conductivity check on page 12 for details on this value.

• Fresh water deployment—add a 1 Hz offset to the zero conductivity value of the
sensor.

• Salt water deployment—add a 500 Hz offset to the zero conductivity value of the
sensor.

HydroCAT-EP V2
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9. Deployment Setup step 6: Put a check in the box to set the internal clock of the
sensor to the same time as the PC.

• Put a check in the box "Clear HydroCAT/EP data" to erase the data from the
internal memory of the sensor.

• If necessary, enter a pressure offset. If the sensor is deployed at sea level, enter
0.0 in the "Pressure Offset" area. The range is from -3402823 to 3402823.

10. Deployment Setup step 7: Enter the approximate minimum temperature of the water
in which the sensor will be deployed.

• Enter the approximate depth of water in which the sensor will be deployed.
• Enter the time interval between each sample for either autonomous or logger-

controlled (polled) operation.

• Range for HydroCAT: 10–21600 seconds
• Range for HydroCAT-EP: 75–21600 seconds

The calculated battery capacity and the number of 24-hour periods that the sensor
can operate is given as a reference. Note: The software calculates "Battery
Endurance" for new batteries only. Deployment time decreases for used batteries.

11. Push Next.
12. Deployment Setup step 8 (optional): make a Deployment Report.

• Enter the "Operator Name."
• Enter any text in the "Comments" area.
• Push Browse to change the location at which the report is saved on the PC.
• Put a check in the box next to "Overwrite if Existing" to save the new report only.

13. Push Finish. The sensor disconnects from the software.

• If the sensor was set up in a logger-controlled or "polled" mode, use the controller
unit to control the collection of data.

• If the sensor was set up in an autonomous mode and there is a check in the
"Transmit in Real Time" box from Step 2 of the Deployment Setup, start a
terminal program to monitor data in real time.

14. When the deployment is complete, the user can connect to the software again and
push Transmit Data in the Dashboard to move the data that is saved in the sensor to
the PC.

4.3 Performance checks
4.3.1 Temperature check

1. Push Temperature Check in the Dashboard area.
2. Push Next to start the check.
3. Enter the water temperature in °C in the "Temperature" area.
4. Push Start.

The software takes a few minutes to collect data for the test. The results show in the
"Status" area.

HydroCAT-EP V2
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5. Push Next.
6. Push Next.

The software saves a .pdf report in the user-specified location on the PC.
7. Push Finish.

The Temperature Check window closes and the .pdf report shows if the "View" box
has a check in it.

4.3.2 Conductivity check
The software lets the user do both a zero conductivity check and a check to a user-
supplied conductivity standard.

1. Push Conductivity Check in the Dashboard.
2. Push Next to start the check.
3. At step 2 of 6, "Zero Conductivity Frequency Check": enter the first value from the

"INST FREQ" column on the calibration page supplied by the manufacturer.
4. Push Start.

5. Push Next.
The software shows the steps to complete the check for the user-supplied
conductivity standard.

6. Push Next.

HydroCAT-EP V2
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The software is ready to do the check of the user-supplied conductivity standard.
7. Enter the value of the conductivity standard in step 4.
8. Push Start.
9. The user can make a report.

• Enter any text in the "Notes" area.
• Push Browse to change the location where the report is saved on the PC.
• Change the "Report File Name."
• Put a check in the "View" box so that the report automatically opens when it is

completed.
• Put a check in the "Overwrite file if it already exists" box to save only the new

information.
10. Push Finish.

The Conductivity Check window closes and the report opens if the "View" box has a
check in it.

4.3.3 pH check
Make sure that the pH values of the sensor agree to ±0.05 pH with the manufacturer-
supplied calibration values. Refer to the sensor user manual for details to prepare the
sensor for this check.

1. From the Dashboard, push pH Calibration.
2. Do the steps for each pH standard of 4, 7, and 10.
3. Optional: make a pH calibration report.

4.3.4 Optics check
Make sure that the optical values of the optional optical cap agree to within 20% of the
manufacturer-supplied calibration values of the sensor.

1. To "pair" a new check cap with the optics:

a. Go to the Sensor menu, then HydroCAT-EP, Advanced, then Pair Optics Cal
Cap.

b. Enter the serial number of the new calibration cap, then push OK. The software
updates the reference values in the sensor.

c. Push OK to finish.
2. Do the steps below to do a check with a currently owned optical check cap.
3. Push Optics Check in the Dashboard area.
4. Push Next.
5. Push Start.

The software looks at the calibration values saved in the sensor. This will take
approximately 2 minutes.

6. Push Next.

HydroCAT-EP V2
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The Create Optics Check Report window shows.
7. The user can make a report.

• Enter any text in the "Notes" area.
• Push Browse to change the location where the report is saved on the PC.
• Change the "Report File Name."
• Put a check in the "View" box so that the report automatically opens when it is

completed.
• Put a check in the "Overwrite file if it already exists" box to save only the new

information.
8. Push Finish.

The window closes and the report opens if the "View" box has a check in it.

4.4 Transmit data
1. Push Transmit Data in the Dashboard area.

The Transmit Data window shows.

• Information in the Memory Summary lets the user see the available data storage
in the sensor.

• "Bytes" is the amount of memory in use.
• "Samples" is the number of samples the sensor has collected and stored.
• "Free Samples" is the number of samples the sensor can store.
• "Sample Length" is sensor-specific and shows the length of each data record

that the sensor stores.
2. In the "Transmit Type" drop-down menu in the Data Transmit Options area, select

either "All Data" or "Block size (bytes)."

• "All Data": all data stored in the sensor is transmitted to the PC in both .csv
and .sbsdat file types.

• "Sample Number Range": a user-specified range of samples. Select the specific
samples in the Sample Number Range area.

3. In the Data Transmit area, the software automatically selects the fastest baud rate to
use to transmit data, which is typically115200.
The software temporarily increases the sensor's baud rate to upload data more
quickly. After the transmission is complete, the software changes the baud rate to
what it was before data was transmitted.

4. In the Output CSV Data File area, type a new file name or use the automatically
generated file name.

5. Optional: change the time stamp to UTC.
6. Push Transmit.

• The data is transmitted to the PC.
• The software saves a raw .sbsdat file and automatically converts the data to a

readable .csv file type.
• The Transmit Progress window shows the status of the file transmission and

conversion.
• The default is a check in the boxes for "Show Data when Conversion Completed"

and "Close this Dialog when Conversion Completed."

HydroCAT-EP V2
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Section 5 ECO V2

5.1 Settings tabs
Push [Sensor] Settings to change the settings of a connected sensor to verify sensor
function or set up for deployment.

5.2 Verify operation
Do the steps below to make sure the sensor operates, collects, and stores data before
further setup and deployment. Note that the sensor collects and stores (if equipped with
memory) all available parameters. The user can use the software to see a subset of the
collected data. Refer to Output description on page 22 for an example of the data that
the sensor collects.

1. Connect the test cable to the sensor, the PC, and a regulated power supply set at
12 V.

2. If necessary, start the software.
3. If necessary, go to the UCI menu, then Preferences to look at or change the

directory in which collected data will be stored.
4. Push OK to save any changes, or Cancel if no changes were made to the "Default

Data Directory."
5. Push Connect in the Dashboard area or from the Sensor menu item at the top of the

UCI window.
Refer to Sensor dashboards on page 3 for details about the Dashboard area.

6. If necessary, change the "Instrument Type" to agree with the connected sensor.
7. Put a check in the "Try All Baud Rates" box.

The software automatically finds the correct baud rate.
8. Push Connect.

The "Connection Mode" turns yellow, then green and the Mode changes to "Setup."
9. Push Get ECO V2 Settings in the Dashboard area of the connected sensor to look at

the parameters that will show in the output.
The Output Format tab shows. The basic output parameters are FrameSync, Header,
Time and Date, and engineering units for each of the channel(s) of the sensor.

10. Push Cancel.
Refer to Autonomous operation on page 23 for details to change the Output Format
settings.

11. In the Samples tab, put a check in the box next to "Sample Continuously" or set a
time interval between samples.

12. In the Transmit Data tab, put a check in the box for the sensor to transmit data in real
time to an externally connected logger or controller.
The default serial baud rate, typically 19200, is supplied by the software and does not
need to be changed.

13. Push Apply to store the settings in the sensor.
14. Push Select Sensors in the Time Series graph.
15. Put a check in the box next to any additional parameters, so that they will show in the

Time Series graph.
16. Push Start in the Dashboard area or use the Start icon (green circle with a white

arrow) under the UCI menu options.
The sensor collects data and stores it in the ECO V2. A Data Collection tab shows so
the user can choose Start Save to File so that the collected data is also saved to the
PC to look at before it is transmitted from the memory of the ECO V2. Change the
location to which the data is saved if necessary, or close the window.

17. Let the sensor collect data for several minutes.
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18. Push Stop in the Dashboard or use the icon under the UCI menu options.
The "Connection Mode" shows "Setup."

19. Optional: push Disconnect to disconnect the ECO V2.
20. Go to the directory on the PC in which the data was saved to see the collected data.

5.2.1 Output description
The sensor always collects data for all parameters for which it was built. Data is collected
in binary. The UCI software converts the data into a .csv format.
The user can select which values to see as output. From the ECO V2 Settings window,
push Modify Format to see the options.
Field Format

• Variable (default setting): The output fields expand according to the size of the
individual output. There is only one delimiter without any extra whitespace. Each
record is the minimum size for each set of data.

• Fixed: The output fields are padded with leading spaces so each output field uses the
same space that a maximum value output would use. This makes each output record
the same length.

Field Delimiter

• Space: data units are separated by spaces.
• Comma: data units are separated by commas.
• Tab: data units are separated by tabs.

Enable Checksum Output
Turns on or off a CRC checksum value at the end of each line of data. The software uses
this to determine if there was an error when the data was transmitted and that data
should be ignored.

Parameter Description

FrameSync Enter the ASCII framesync-. Command must end with a "-".

FrameSyncHeader Shows the model and serial number of the sensor such as ECOv2 00102.

USDateFormat mm/dd/yy

EURODateFormat dd/mm/yy

ISO-DateTimeMS yyyy-mm-ddThh:mm:ss.ttt, where ttt is milliseconds

Time hh:mm:ss

TimeMS hh:mm:ss.ttt

Counter A sample that increments by 1 for each sample taken during a single burst. Counter reaches the
burst size as the burst is completed.

Countdown A counter that starts at the burst size and decrements by 1 for each sample taken during a single
burst. Countdown reaches 1 as the burst is completed.

SampleNumber A counter that starts at zero for the first sample and increments by 1 for each sample recorded. The
counter increments with each collected sample and is only reset with the memory is reset.

vMain The voltage of the input power supply or the input battery.

QASummary A single digit that shows the worst-case Quality Assurance-Quality Control of Real-Time
Oceanographic Data.

NumericQA A decimal display of the QARTOD status, with 1 digit for each parameter, a human-readable form of
the entire QARTOD status.

HexQA A hexidecimal display of the QARTOD status. Each HexASCII equals 2 QARTOD parameters. A
machine-readable form of the entire QARTOD status.

ECO V2
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Channel parameters (where x = 1–4, dependent on whether a sensor has 1, 2, 3, or 4 channels of output)

MxEX Excitation wavelength, nm

MxEM Emission wavelength, nm

MxHiGain High gain, counts

MxLoGain Low gain, counts

Mx 5 Volts Maximum voltage

MxLTC LED temperature compensation, counts

MxScaledRaw Raw output, counts

Mx Units Engineering output, µg/L

MxUnits Engineering units (µg/L, m-1 sr-1, ppb, NTU)

5.3 Deployment wizard
Use the deployment wizard in the UCI software to set up the sensor for either
autonomous or polled (controlled) operation.
To start the deployment wizard, go to either the Sensor menu or push Deployment
Wizard in the dashboard for the sensor.

5.3.1 Autonomous operation
1. Start the software if necessary.
2. Push Deployment Wizard in the dashboard of the connected sensor.
3. Select autonomous operation. Push Next.
4. Select the way data is transmitted from the sensor:

a. Put a check at "Transmit Data in Real Time" to see data in a connected controller
or PC as it is collected.
Note that if this is turned off, power consumption is reduced and the battery life is
extended.

b. Push Modify Format to change the parameters that are transmitted from the
sensor.

• "Field Format" is "Variable" or "Fixed."
• "Field Delimiter" is "Tab" or "Comma" or "Space."
• "Enable Checksum" enables a value at the end of each line of data, used by

the software to determine if there are data transmission errors.

ECO V2
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c. Push Next if no changes are necessary. Refer to Output description on page 22
for details about each parameter.

5. Select the frequency and interval of data collection:

a. Select a data rate: 1 Hz is the default of one sample/second.
b. Put a check in the box at "Sample Continuously" so that the sensor operates

continuously at the selected data rate, or
c. Remove the check and select the "Cycle Start Interval."
d. "Number of samples per Cycle": Enter a value of 1–86400.
e. "Number of cycles": enter a value of 0–65535.
f. Push Next.

6. Set the clock used by the sensor:

a. Push Synchronize ECO V2 clock to computer.
b. To erase the data stored in the sensor and set the event counters to 0, put a

check in the box.
7. Enter the date and time for the sensor to start data collection.
8. Battery endurance calculator:

a. The information in the Instrument tab is set by the manufacturer.
b. Use the manufacturer-supplied batteries and enter the "Minimum Deployment

Temperature" in the Environment tab.
c. The software helps the user calculate the life of other brands and types of

batteries.
d. Push Next.

9. Optional: make a deployment report:

a. Enter any information to be added to the deployment report.
b. Push Browse to set the location on the PC to which the report will be saved.
c. The report will show on the PC if there is a check in the box at "View Report."

10. Push Finish to close the Deployment Wizard.
11. The sensor will start data collection at the user-specified date and time.

ECO V2
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5.3.2 Polled operation
1. Select polled operation. Push Next.
2. Push Modify Format to change the parameters that are transmitted from the sensor,

or push Next. Refer to Output description on page 22 for details about each
parameter.

3. Select the frequency and interval of data collection:

a. Enter the value for "Polling Interval" to set the start time of each interval.
b. "Number of samples per Poll": Enter a value of 1–86400.
c. Select a data rate: 1 Hz is the default of one sample/second.
d. Push Next.

4. Battery endurance calculator:

a. Use the manufacturer-supplied batteries and enter the "Minimum Deployment
Temperature" in the Environment tab.

b. The software helps the user calculate the endurance of other brands and types of
batteries.

c. Push Next.
5. Set the clock used by the sensor:

a. Push Synchronize ECO V2 clock to computer.
b. Put a check in the box to erase the data stored in the sensor and start the event

counter again.
6. Optional: make a deployment report:

a. Enter any information to be added to the deployment report.
b. Push Browse to set the location on the PC to which the report will be saved.
c. The report will show on the PC if there is a check in the box at "View Report."

7. Push Finish to close the Deployment Wizard.
8. The sensor will start data collection when directed by the controller.

5.4 Transmit data
1. Push Transmit Data in the Dashboard area.

The Transmit Data window shows.

• Information in the Memory Summary lets the user see the available data storage
in the sensor.

• "Bytes" is the amount of memory in use.
• "Samples" is the number of samples the sensor has collected and stored.
• "Free Samples" is the number of samples the sensor can store.
• "Sample Length" is sensor-specific and shows the length of each data record

that the sensor stores.
2. In the "Transmit Type" drop-down menu in the Data Transmit Options area, select

either "All Data" or "Block size (bytes)."

• "All Data": all data stored in the sensor is transmitted to the PC in both .csv
and .sbsdat file types.

• "Sample Number Range": a user-specified range of samples. Select the specific
samples in the Sample Number Range area.

3. In the Data Transmit area, the software automatically selects the fastest baud rate to
use to transmit data, which is typically115200.

ECO V2
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The software temporarily increases the sensor's baud rate to upload data more
quickly. After the transmission is complete, the software changes the baud rate to
what it was before data was transmitted.

4. In the Output CSV Data File area, type a new file name or use the automatically
generated file name.

5. Optional: change the time stamp to UTC.
6. Push Transmit.

• The data is transmitted to the PC.
• The software saves a raw .sbsdat file and automatically converts the data to a

readable .csv file type.
• The Transmit Progress window shows the status of the file transmission and

conversion.
• The default is a check in the boxes for "Show Data when Conversion Completed"

and "Close this Dialog when Conversion Completed."

5.5 QA data analysis
Use the data analysis filters to select the measurands and filters for data analysis. Start
the filters from either the sensor Dashboard or the Data menu. Refer to Data QAQC
on page 27 for details on sensor QAQC.

1. Enter the "File Name" or Browse to the .sbsdat file type to process. Push Open, then
Next in Step 1.

2. Put a check in the box next to any or all of the Pass, Suspect, or Fail criteria on which
to filter. Push Next.

3. Put a check in the box next to any or all of the parameters to filter. Push Next.
4. Enter any dark counts or scale factor values for a specific measurand. Push Next.
5. Enter the Median and Average Filter Size. Push Next.

The sensor uses these values in its real-time calculation of raw and engineering units.
6. To change the directory in which the analysis will be saved, push Browse. Push

Finish for the software to start the analysis
The QA Analysis Graph shows next to the Time Series tab in the software.

7. Push Select Measurands and Filters for more options to filter data. Push OK.
The changes show in the graph.

8. To see a data file that has an analysis, go to Data, then ECO V2, and select Plot QA
Env Processed Data. Select the .csv file to plot, then select Open.
The data shows in the QA Analysis Graph. Push Select Measurands and Filters to
change the measurands that show.

5.6 QA data analysis output format
The output format from the data analysis operation is a comma-separated (.csv) file with
various measurands. The file name includes "analysis" instead of "Data." The example
below is from a sensor that measures backscattering and chlorophyll. Header information
is approximately 170 rows with information about the measurands selected for the
analysis.
The file starts with—
<!-- ECO V2 -->
<SBS_QA_File>
and ends with—
</QAProcessingSettings>
</SBS_QA_File>

ECO V2
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The graph shows in the software next to the Time Series tab.

5.6.1 Data QAQC
Current efforts are to follow the Quality Assurance-Quality Control of Real-Time Oceanographic Data (QARTOD) as written
by the US Integrated Ocean Observing System (IOOS).

QC flag values

Flag Value Description

Pass (green) 1 Data have passed the QC test and are deemed adequate for use.

Suspect (yellow) 2 Data are considered to be either suspect or of high interest.

Fail (red) 3 Data are considered to have failed QC tests or are missing.

ECO V2
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QC tests

• Input voltage
• Wiper position (if so-equipped)
• Gross range
• Timing
• Date and time
• Median filter

Input voltage: does the sensor operate within the specified range of 7–15 V?

Flag Value Description

Pass 1 Input voltage is between 7 and 15 

Fail 3 Input voltage is below 7 or above 15 

Wiper position: is the wiper in the correct position for operation?

Flag Value Description

Pass 1 Wiper is in the correct position

Fail 3 Wiper is not in the correct position

Gross range: is the output a numeric value within the specified range of 0–65,536 counts?

Flag Value Description

Pass 1 Any value between 0 and 65,536 

Fail 3 Any value higher than 65,536 or any negative value

Timing: does the frequency of the user-selected data output agree with the frequency of data output from the sensor?

Flag Value Description

Pass 1 The user-selected output frequency agrees with the sensor output frequency

Fail 3 The user-selected output frequency does not agree with the sensor output frequency

Date and time: does the date and time show in a valid format?

Flag Value Description

Pass 1 The date and time show in a valid format

Fail 3 The date and time show in something other than a valid date format

Median filter: removes spikes from the raw data set. The filter window can be adjusted to the variance in the data set to the
expected variance time scale, e.g. tidal. The median filter replaces the QARTOD spike test with the advantage that the
threshold does not have to be set by the operator for each measurand.

ECO V2
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Section 6 SeaFET V2 and SeapHOx V2

6.1 Settings tabs
Push [Sensor] Settings to change the settings of a connected sensor to verify sensor
function or set up for deployment.

6.1.1 Set up output format
This tab shows the order of the data from the sensor.

6.1.2 Set up data collection
Select the values for data collection frequency, how it is transmitted, and the reference
salinity.

1. In the "Data Collection" area, enter a value between 10–21600.
2. Put a check in the "Transmit Data in Real Time" box so that the sensor will send

measurements to a connected PC in real time.
3. In the "Reference Salinity" area, enter a value between 0–50.0.
4. Push Apply.

6.1.3 Pump settings
If the sensor has an external pump attached, set the amount of time the pump operates.

1. Enter a value between 0–255 in the "Pumping Duration" area. Note that 0 =
continuous pump operation.

2. Push Apply.

6.2 Configure sensor with deployment wizard
The deployment wizard in the UCI software makes it easy to set up and configure the
sensor for a specific deployment.
With the sensor connected to a power supply (or internal batteries if so equipped) and a
PC that has the UCI software installed, start the software, turn on the power supply, start
communication with the sensor and push Deployment Wizard in the Dashboard.
Autonomous operation mode

1. Push Synchronize SeaFET clock to computer. The sensor and the PC show the
same time. Put a check in the box to erase all of the data stored in the sensor and set
the event counter to 0 when the deployment starts.

2. Set the date and time for the sensor to start data collection.
3. Transmission: put a check in the box to send collected data in real time to a

connected controller. Data is still stored in the sensor if this box does not have a
check in it.

4. Pump Settings: put a check in the box to enable operation of an external pump.
Values can be between 0–255. If set to 0, the pump will operate continuously.

5. Calculate Battery Endurance. This calculation uses an estimate of the voltage of
new batteries. It does not measure voltage directly.

a. Enter the temperature of the water in which the sensor will be deployed.
b. Enter the sample interval (40–21600).

6. Make a deployment report to see sensor statistics, calibration values, and settings.
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Polled (controlled) operation mode

1. Push Synchronize SeaFET clock to computer. The sensor and the PC show the
same time. Put a check in the box to erase all of the data stored in the sensor and set
the event counter to 0 when the deployment starts.

2. Current Output Format shows the order of the data values from the sensor.
3. Calculate Battery Endurance. This calculation uses an estimate of the voltage of

new batteries. It does not measure voltage directly.

a. Enter the temperature of the water in which the sensor will be deployed.
b. Enter the polled interval (1–86400).

4. Make a deployment report to see sensor statistics, calibration values, and settings.

6.3 Transmit data
1. Push Transmit Data in the Dashboard area.

The Transmit Data window shows.

• Information in the Memory Summary lets the user see the available data storage
in the sensor.

• "Bytes" is the amount of memory in use.
• "Samples" is the number of samples the sensor has collected and stored.
• "Free Samples" is the number of samples the sensor can store.
• "Sample Length" is sensor-specific and shows the length of each data record

that the sensor stores.
2. In the "Transmit Type" drop-down menu in the Data Transmit Options area, select

either "All Data" or "Block size (bytes)."

• "All Data": all data stored in the sensor is transmitted to the PC in both .csv
and .sbsdat file types.

• "Sample Number Range": a user-specified range of samples. Select the specific
samples in the Sample Number Range area.

3. In the Data Transmit area, the software automatically selects the fastest baud rate to
use to transmit data, which is typically115200.
The software temporarily increases the sensor's baud rate to upload data more
quickly. After the transmission is complete, the software changes the baud rate to
what it was before data was transmitted.

4. In the Output CSV Data File area, type a new file name or use the automatically
generated file name.

5. Optional: change the time stamp to UTC.
6. Push Transmit.

• The data is transmitted to the PC.
• The software saves a raw .sbsdat file and automatically converts the data to a

readable .csv file type.
• The Transmit Progress window shows the status of the file transmission and

conversion.
• The default is a check in the boxes for "Show Data when Conversion Completed"

and "Close this Dialog when Conversion Completed."

SeaFET V2 and SeapHOx V2
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6.4 Process data with temperature and salinity corrections

After the data is transmitted to the PC and converted to a .csv file type, it can be further
processed with temperature and salinity corrections.

1. Select the Data menu, then SeaFET, and SeaFET Data Processing. The Dashboard
shows.

2. In the "SeaFET Binary Logged Data File" area, select a data file that was transmitted
to the PC.
It has a .sbsdat file type.

3. Select "Specify Temperature Salinity Data" to see the options for temperature and
salinity.

4. If an external temperature-salinity file is available:

a. Enter the file name in the "Temperature-Salinity External File" area.
b. Select "Temperature from External File" in the "Temperature Options" area.
c. Select "Salinity from External File" in the "Salinity Options" area.

5. If there is no external temperature-salinity file available, use the internal temperature
value stored in the sensor, and a static salinity value.

6. Put a check in the "Offset" box and enter the time in the "Time-Stamp Options" area
for the software to calculate the offset.

7. Select the "Output Directory" for the processed data.
8. Push Process File.

SeaFET V2 and SeapHOx V2
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Section 7 Software reference

7.1 UCI menu
The user can set up the way that the software saves information about the operation of
the sensor and change the way that the data looks from the Preferences menu.

7.1.1 General
Go to the UCI menu, then Preferences, to select the General settings for the sensor.

1. Set the Connection Settings:

• Enter the "Maximum Wakeup Attempts" for the number of times the software will
try to connect to a sensor. Range: 5–15.

• Enter the "Response Timeout" for the interval of time of communication between
the sensor and the software. Range: 5–10.

2. Enter the Default Data Directory:

• Enter the file path or push Browse to find the directory in which to save data from
the sensor.

• If the "Prompt at startup" box has a check in it, the user can change the directory
that the data is stored in every time the software starts.

3. Push Apply.
4. Push OK to save the settings.

7.1.2 Display tab
Note: The software operates faster if the user selects less data and only one or two graphs.

Data that is collected by the sensor shows in the user-selected graphs in the
Performance Optimization Settings area of the Display tab.

• "Enable Real Time Display"—Put a check in this box to see the data as it is collected
in either the software, or if deployed, a terminal program.

• "Enable Time Series Graph"—Put a check in this box to see user-selected data.
Remove the check in the box to so that the graph is disabled and the data does not
show.

• SUNA only: "Enable Spectra Graph"—Put a check in this box to see both dark and
light data in raw counts. Refer to Monitor data in spectra graph on page 42 for
details.

• SUNA only: "Enable Total Absorbance Graph"—Put a check in this box to see the
calculated absorbance. Refer to Monitor data in absorbance graph on page 43 for
details.

Time Series Settings—The default is a check in the box for continuous data collection
that is not limited to a specified amount of time. Remove the check in the box to enable
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the "Time Axis Range Limit" of 60 minutes (default value). Only the most recent hour of
data will show in the Time Series Graph. The user-selectable range is 1–1440 minutes.

7.1.3 Message tab
The software automatically saves files that have information about sensor use, data
collection, and software operation over time. This information helps the user and
Customer Support find problems and troubleshoot.
When the "Display Dialog for Error Level Messages" box has a check in it, the software
saves one of five levels of error messages.

• INFO—The default level. All high-level operations are saved.
• ERROR—Minimum level. Only errors that need to be examined by the user or

Customer Support are saved.
• WARN—Low level. The files that are saved do not have enough information for the

user to make an analysis of how the sensor is used and set up.
• DEBUG—High level. Used to troubleshoot. DEBUG and TRACE files are very large.
• TRACE—The highest level. Used only to troubleshoot.

"Daily Files"—all messages from a single day are saved in one file.
"Rolling Files"—all messages are saved in one file until it is the maximum size specified
by the user. The messages are then saved to a new file. The user specifies the number of
files to keep. The oldest files are erased first.
"Save Lost Bytes"—if this box has a check in it, the software saves all of the unexpected
output from the sensor to a file.
"File Location"—the operating system of the PC determines where these files are saved.

7.2 Sensor menu
The Sensor menus have options for each sensor with which the software communicates.
Refer to the sections on Sensor dashboards on page 3 for more information about these
items.
Advanced Sensor menu items
Common

• Erase Data lets the user erase all of the data stored in the sensor.
• Summary Report lets the user get a summary of the settings stored in the sensor.
• Set Clock lets the user synchronize the time between the PC and the sensor.
• Collect Diagnostics is helpful for troubleshooting.

7.2.1 Make summary report
Get a summary of the settings saved in the sensor.

1. Select Summary Report.

2. Enter any comments about the report (optional).
3. Put a check in the "View Report" checkbox to see the report after it is created.
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4. Push Browse to go to the directory in which to save the report.
5. Push Save Report.

The software makes a .pdf of the summary report.

7.2.2 Collect diagnostics
Use the diagnostic results to look at the current settings and commands sent to the
sensor that are saved as .log files. They are helpful for troubleshooting.

1. Go to the Sensor menu, select the connected HydroCAT, then select Collect
Diagnostics.

2. If necessary, push Browse to change the location on the PC to which the .zip file is
saved.

3. Push OK.
The Diagnostics Created window shows. Push OK to close the window.

4. Go to the .zip file on the PC and extract the files. There are three folders:

• console contains a summary of the operation, calibration, and device
configurations, and the event counter saved in the sensor.

• event log contains .log files useful for troubleshooting.
• reports contains the summary report referred to in Make summary report

on page 34.

7.2.3 SUNA
• Edit Data File Headers lets the user put labels on data files.
• SUNA Self Test—the software does a test of the sensor function. The output shows

in the Instrument Console tab.
• DAC Calibration lets the user do a digital-to-analog calibration (does not apply to

coastal deployments).
• Upload Firmware File lets the user update the firmware in the sensor.
• Administrative Settings is used only by the manufacturer.
• Upload Instrument XML File is an .xml file necessary for the sensor to process data.

7.2.4 HydroCAT-EP V2
• Pair Optics Cal Cap (HydroCAT-EP V2) lets the user enter the serial number of a new

check cap to connect, or "pair" it with the sensor.
• Upgrade Firmware (HydroCAT-EP V2) lets the user install the latest firmware from

the manufacturer.
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7.2.5 ECO V2 sensor menu
• Erase Saved Data lets the user erase all of the data saved in the sensor.
• Deployment Endurance lets the user estimate how long the batteries will last for a

specific deployment.
• Upgrade Firmware lets the user install the latest firmware from the manufacturer.
• Load Factory Defaults lets the user install the manufacturer-set configuration settings.
• Restore Settings from File lets the user configure the settings previously stored in the

PC.
• Enter Legacy Mode lets the user put the ECO V2 into legacy mode. Because legacy

mode is not currently compatible with UCI, the ECO will be disconnected after being
put into legacy mode.

7.2.6 SeaFET, SeapHOx
• Erase Saved Data lets the user erase all of the data saved in the sensor.
• Edit Data File Headers lets the user put labels on data files.
• Upgrade Firmware lets the user install the latest firmware from the manufacturer.

7.2.7 Update firmware
The user can update the firmware in supported sensors with firmware from the
manufacturer's website.

7.2.7.1 Update SUNA firmware
At regular intervals, make sure that the current firmware is installed in the sensor.

1. Go to the manufacturer's web site to get the current firmware for the sensor.
2. Save the firmware to the PC.

The firmware is an ".sfw" file.
3. Make sure that the sensor is connected to the PC and a power supply.
4. Push Connect.
5. Go to the Sensor menu and select SUNA, then Advanced, then Upload Firmware

File.

6. Push Browse to find the firmware file that is saved on the PC.
7. Push Open.
8. Push Upload.

It takes approximately 2 minutes for the software to be updated. The software
disconnects the sensor.
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7.2.7.2 Update HydroCAT-EP V2 firmware
Update the firmware for the sensor in the software program as necessary. The most
recent version is available on the manufacturer's website.

1. Go to the Sensor menu, select HydroCAT-EP V2, select Advanced, then select
Upgrade Firmware.

2. A Select Firmware File window shows.
3. Select the file with the .txt suffix.
4. Push Open.
5. The software updates the firmware in the sensor.

This process will take several minutes. When process is complete, the software will
show the version and build of the new firmware installed in the sensor.

6. Push OK.

7.3 Data menu
The Data menu has sensor-specific options to look at data that has been saved to a PC.

7.3.1 Export data to .csv or MS Excel format
Data from the sensor can be saved to either a comma-separated (.csv) file or a
Microsoft® Excel file with a local or UTC time stamp. Use the software to transmit data
from the sensor and then export that data to a human-readable format.

1. From the Data menu, select Export Stored Data.
2. Push Browse to find the file to export.
3. Select the file from the list.
4. Push Open.
5. Push Next. The current output format shows (all sensors but SUNA).
6. Push Next. Select the options for the file to export:

a. Select either "Excel Workbook" or "Comma Separated Values" in Export File
Format.

b. Select either the "UTC" or "Local" time stamp in Format Options.
7. Push Browse to select the directory in which the exported data will be saved.
8. Push Finish.

7.3.2 Show data from multiple sensors
The software lets the user show data that has been saved on the PC from each
supported sensor. The user can select up to 12 parameters to look at.

1. Go to the Data menu, then Show Data from Sensor.
2. Go to the area of the first supported sensor and push Browse to go to the .csv file-

type.
3. Select the file, then push Open.
4. Push Select Sensors to Show.
5. Put a check in the box of each parameter to look at in the Time Series graph.
6. Push OK.

Software reference

37



7.3.3 SUNA data menu options

7.3.3.1 Reprocess SUNA data
The user may find that it helps to use the Reprocess Data option under some conditions.

• The settings for the sensor were incorrect. Use the "Reprocess" option to correct for
this, such as when a sensor was deployed in seawater, but set up for fresh water.

• The data that is collected has changed over an extended deployment. Data is
processed with an updated reference spectrum file, and compared to the original
reference.

• Water temperature and salinity data are collected. These can be put together with the
spectral data from the sensor to get more accurate nitrate data (Sakamoto et al.
2009).

Note that the data files collected with SDI-12 (standard sensor) do not contain spectral
data and cannot be reprocessed.

1. If necessary, start the software and supply power to the sensor.
2. Go to the Data menu, then select SUNA, then Reprocess Data.

The Reprocessing Dashboard shows.

3. Push Browse to find the package file, the reference file, and the data file. All are
required to reprocess the data.

• "Instrument Package File" is an .xml file that describes the data from the sensor.
• "Calibration File" is for the reference spectrum and the extinction coefficients of

the chemical species. Use the calibration file that matches the time during which
data was collected. Calibration files are stored in the sensor unless the user
erases them.

• "Nitrate Data Files" will show in the dashboard and the user can select some or
all to process. Spectral data, which is recorded in full ASCII, full and reduced
binary, and APF frames, is required to process nitrate data. Use the reduced
binary and APF frames to reprocess data from seawater deployments. Note that
the APF frames only let the user reprocess data that was collected with the
"integration time adjustment" turned off.

4. The user can change the "Output Directory" if necessary.
5. The reprocess operation will be faster if there is no check in the "Graph Results" box.
6. Push Process Selected File(s).

The software starts to reprocess the data.
7. Open the files on the PC.

7.3.3.1.1 Nitrate reprocessing details
Settings in "Processing Settings" and the "Temperature & Salinity Correction" areas do
not show until selected by the user. The user can change these settings as necessary to
get better quality data.
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Processing settings

• The default "Enable Raw Data Checksum Validation" is on, with a check in the box. If
it is turned off, raw data can be processed even when the checksum values have
changed after data is collected.

• The default "Fitting Range" is 216.5–240 nm. If the wavelength is shorter, seawater
typically causes extinction, and a poor signal-to-noise ratio. If the wavelength is
longer non-characterized materials can be absorbed, which causes a bias in the
processed concentrations.

• The default "Max Absorbance Threshold" is 1.3. The precision of the measured
absorbance starts to decline at this value. At 2.5 absorbance units, the precision is at
the "noise floor." The precision of the processed data is better when the low-quality
parts of the "fitting range" are not processed.

• The default Seawater Calibration has no check in the box at "Deployed in Fresh
Water." Put a check in this box if the sensor was calibrated for seawater but deployed
in fresh water. Data that was collected in seawater with a check in the "Deployed in
Fresh Water" box gives incorrect nitrate concentrations.

Temperature and salinity correction
Seawater has a temperature-dependent absorption rate. Make sure to consider this so
that imprecision does not affect the nitrate concentration that is measured. To mitigate
this effect, use the sample temperature and salinity values in the nitrate calculation in the
host software for post-processing. Note that spectra and related temperature and salinity
data is necessary. The temperature-salinity correction comes from MBARI (cf. Carole M.
Sakamoto, Kenneth S. Johnson, and Luke Coletti, Limnol. Oceanogr.: Methods 7, 2009.)
"Temperature and Salinity Correction" is available if the sensor is calibrated for seawater
and water temperature and salinity data ("T-S data") are collected. This data can come
from frames if the sensor operates in APF mode (SUNA V2 deep only), or from an
external file.

1. The default "Activate Temperature & Salinity Correction" has no check in the box. Put
a check in this box to add T-S data correction information.

2. Select either "CTD Data from SUNA APF Mode Frames" or "Data from External File"
to get T-S data from an external file. The required ASCII format is "YYYY-MM-DD
hh:mm:ss, Temperature (c), Salinity (PSU)" e.g. 2012-11-10 90:08:06,12.3,34.567.

3. Push Browse to find the file. For "External Files": at the bottom of the new window
choose either "Sea-Bird CNV Data File" or "CSV Data File" in the "Files of type:"
area. Push Open. A green check will show in the T-S Correction area of the software
when the data is loaded.

4. The data files must have the same time stamp if more than one is selected. If
necessary, put a value in the "Time Offset" area to align the time stamps.
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5. Put a check in either the "Single Output File" box or the "Graph Results" box in the
Output Data Files area of the dashboard.

• If the user processes more than one file, the output can be directed to a single file
of output. Otherwise, each file that is input to process will have one file of output.

6. Push Process Selected File(s).

• A graph of the processed data shows in the Reprocessed Nitrate Graph. The
upper area shows how the chemical species combine to show measured
absorbance. The lower area shows a timeline of the original and reprocessed
nitrate concentrations. Use the slider under the timeline to select one
measurement and see the concentration to the left.

7.3.3.2 Show SUNA data
Use Show Data form Sensor to see the data that has been saved on the PC.
The SUNA uses the files below to process data:

• The .xml instrument package file. For Windows, this is C:\Users\%USERNAME\My
Documents\Sea-Bird-Scientific\SUNA. For Mac OS X, this is /Users/Home/Sea-Bird-
Scientific/SUNA.

• The raw data file to process.
• The calibration file for the sensor.

1. Push Show Data from Sensor.
2. If necessary, push Browse to find the .xml "Instrument Package File" that is saved on

the PC. A typical file is "SUNA_xxx_001.xml, where xxx is the serial number of the
sensor.

3. Push Browse to find the "SUNA Raw Data File" to see the data that is saved on the
PC.

4. Push Browse to find the current "SUNA Calibration File" on the PC. A typical file is
SUNA_xxxn.CAL, where xxx is the serial number of the sensor, and n is the
calibration version.

5. Push Finish.
The saved data shows in the Time Series tab.

7.3.3.3 Convert SUNA raw data
The Convert SUNA raw data function has been replaced with "Transmit Data from
Sensor" in the software. Go to the Data menu and select Export Data to transmit the data
from the SUNA. Refer to Export data to .csv or MS Excel format on page 37 for details.

7.3.3.4 Convert APF data
The user can convert the Autonomous Profiling Float (APF) data from a deep-rated
SUNA sensor into Full_ASCII so that data can be re-processed.

1. Go to the Data menu, then SUNA, then Convert APF Data.
2. If necessary, find the "Instrument Package File."
3. Push Browse to find the "Raw Data Files" to convert.
4. If necessary, push Browse to change the "Output Directory" for the data.
5. Push OK.

The converted data shows in the software.

7.3.3.5 Compare reference spectrum files
Compare the change between two reference spectrum files. The amount of change is
related to the time interval between the updates and the amount of lamp use during that
time.
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Note that this procedure is done automatically by the software when the user updates the
reference spectrum for the sensor. Refer to Update reference for more information.

1. From the Data menu, select SUNA, then Compare Calibration.
2. Push Browse to find the first calibration, or reference file, to compare.
3. Push Browse to find the second file to compare. Note that the files must be from the

same sensor.
4. Push Compare.

A typical update interval of 3–6 months with no more than 100 hours of lamp use
should cause a change of no more than 10% in the 215–240 nm interval.
Below 215 nm, larger relative changes are normal.
Above 240 nm, the change is smaller than at the 215–240 nm range.
If there is a large change, do several reference updates 12–24 hours apart to monitor
the stability of the reference spectrum.

7.3.4 ECO V2 data menu options
Refer to QA data analysis on page 26 for details about the QA analysis of data.

7.3.5 Process SeaFET data
The software can process the binary raw .xml data from the sensor. The processed file is
a comma-separated file with header information. The file name is appended with "_pro."

1. From the Data menu, go to SeaFET, then SeaFET Data Processing.
2. Push Browse to find the binary data file to process.
3. Optional: push the down-arrows next to "Specify Temperature Salinity Data" to select

options.

• Push Browse to find the Temperature-Salinity External File (if collected).
• Optional: select the Time Stamp Option.
• Select the Temperature Option and enter any offset.
• Select the Salinity Option.

4. Push Browse to select the "Output Directory" for the data.
5. Push Process File.

7.4 View menu
Dashboards— Go to the View menu and Dashboards to select the dashboard for a
specific sensor.
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Graphs

• Time Series Graphs—all supported sensors.
• SeaFET—Processed pH graph.
• SUNA—Spectra, Absorbance, or Reprocessed Nitrate.
• SUNA Spectra graph: the user can push Configure to change the number of graphs

to view. The "Graph History Limit" range is 1–2147483647. Put a check in the "Graph
History Unbounded" box to see the total number of graphs. Default value: no check in
the box and a "Graph History Limit" of 1.

• SUNA Absorbance graph: the user can change the "Min. Wavelength Cutoff" to
between 150–400 nm to change the scale of the graph. Push Configure to change
the number of graphs to view. The "Graph History Limit" range is 1–2147483647. Put
a check in the "Graph History Unbounded" box to see the total number of graphs.
Default value: no check in the box and a "Graph History Limit" of 1.

• SUNA Reprocessed Nitrate graph: the user may find that it helps to reprocess data
under some conditions.

Output— Go to the View menu and select Output, then any of the three options:

• Instrument Console: the current settings in the sensor
• Processing Console: the data collected by the sensor in a comma-delimited format
• Application Console: the commands sent to the sensor from the software.

Real Time Data— Go to the View menu and select Real Time Data to select the
parameters that the specific sensor will use for data collection.
Data Collection— Go to the View menu and select Data Collection to select the location
on the PC in which the collected data is saved.
Acquisition Monitor— Used by the manufacturer for troubleshooting.
Message File— Used by the manufacturer for troubleshooting.

7.4.1 Time series graph
1. Look at the data in the Time Series graph. The user can look at data in real-time for

each sensor that has power supplied, is connected and is in communication with the
software.

• Put a check in the box next to "Time Axis" to push Zoom In and Zoom Out to
change the scale of time.

• Put a check in the box next to "Range Axis" to push Zoom In and Zoom Out to
change the scale of the data.

• To move the data in any direction, push the "Ctrl" key on the PC keyboard and
the left button of the mouse pointer at the same time.

• To select a specific part of the data to zoom in on, pull the mouse pointer
diagonally.

• Push Auto Range to see the data for each selected parameter. The software
adjusts the scale so that the data will always show.

• Push Default Ranges to go back to the manufacturer-set default scale for each
parameter.

• Put a check in the box next to "Show Data Points" to see the value of the
collected data when the mouse moves over each point.

• Push Select Sensors To Display to change the parameters to look at in the
Time Series graph.

7.4.2 Monitor data in spectra graph
The Spectra graph shows both the dark and light data in raw counts.
The dark counts are from thermal noise. The light counts are the measured output minus
the dark counts.
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The measured spectrum is always flat below 200 nm, and then has four or five peaks.
The peaks are approximately 25 nm apart in the lower wavelength range and up to 50 nm
apart in the upper range.

7.4.3 Monitor data in absorbance graph
The Total Absorbance graph shows the calculated absorbance from 210 to 370 nm. This
graph is an alternative to the Spectra graph. The absorbance graph should be flat when a
sample of DI water is collected. The absorbance increases as absorbing species such as
nitrate and bromide are added to samples.

If necessary, push Stop.

7.4.4 Reprocess SUNA data
The user may find that it helps to use the Reprocess Data option under some conditions.

• The settings for the sensor were incorrect. Use the "Reprocess" option to correct for
this, such as when a sensor was deployed in seawater, but set up for fresh water.

• The data that is collected has changed over an extended deployment. Data is
processed with an updated reference spectrum file, and compared to the original
reference.

• Water temperature and salinity data are collected. These can be put together with the
spectral data from the sensor to get more accurate nitrate data (Sakamoto et al.
2009).

Note that the data files collected with SDI-12 (standard sensor) do not contain spectral
data and cannot be reprocessed.

1. If necessary, start the software and supply power to the sensor.
2. Go to the Data menu, then select SUNA, then Reprocess Data.

The Reprocessing Dashboard shows.
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3. Push Browse to find the package file, the reference file, and the data file. All are
required to reprocess the data.

• "Instrument Package File" is an .xml file that describes the data from the sensor.
• "Calibration File" is for the reference spectrum and the extinction coefficients of

the chemical species. Use the calibration file that matches the time during which
data was collected. Calibration files are stored in the sensor unless the user
erases them.

• "Nitrate Data Files" will show in the dashboard and the user can select some or
all to process. Spectral data, which is recorded in full ASCII, full and reduced
binary, and APF frames, is required to process nitrate data. Use the reduced
binary and APF frames to reprocess data from seawater deployments. Note that
the APF frames only let the user reprocess data that was collected with the
"integration time adjustment" turned off.

4. The user can change the "Output Directory" if necessary.
5. The reprocess operation will be faster if there is no check in the "Graph Results" box.
6. Push Process Selected File(s).

The software starts to reprocess the data.
7. Open the files on the PC.

7.5 Window and Help menus
The user can change how the software shows different windows and tabs. The Help
menu has the .pdf version of the user manuals for supported sensors and this software
reference.

• Close Current Window—closes the selected tab (highlighted in blue).
• Close all Windows—closes all tabs except the UCI Dashboard.
• Configure Window—

Maximize: increases the size of the selected tab to fill the software screen size.
Float: unlocks the selected tab from the software screen so that the user can move it
to other locations on the PC screen.
Float Groups: the same as Float above, but all tabs that are open are unlocked so
that the user can move them to other locations on the PC screen.
Minimize: minimizes the selected tab and moves it to the side of the software screen.
Minimize Group: minimizes the open tabs in the "Console," "Dashboard," or "Graph"
areas of the software.
Dock: locks the tab that the user selected to "float" back to its previous position in the
software window.
Dock Group: the same as Dock above, but all tabs that are open are locked back into
their previous position in the software window.
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